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EXCEL CHAPTER 11:  COLLABORATION AND WORKBOOK DISTRIBUTION
Available Instructor Resources
	Resource
	File Name
	Found

	Student Data Files
	various
	Online Instructor Resource Center

	Solution Files
	various
	Online Instructor Resource Center 

	Answer Keys 
	 
	Online Instructor Resource Center 

	      Matching
	e11_answerkey_match
	

	      Multiple Choice
	e11_answerkey_mc
	 

	      Concepts Checks
	e11_answerkey_concepts
	 

	Scorecards
	e11b1Tips_scorecard

	Online Instructor Resource Center 

	Scoring Rubrics
	e11b1Tips_rubric
	Online Instructor Resource Center 

	Annotated Solution File
	e11b1Tips_annsolution
	Online Instructor Resource Center 

	Scripted Lecture (Script)
	e11_script
	Online Instructor Resource Center 

	    Scripted Lecture Solution
	e11_script_solution
	

	    Scripted Lecture Data
	e11_script_data
	 

	PowerPoint Presentation
	e11_powerpoints
	Online Instructor Resource Center 

	Testbank
	e11_testbank
	Online Instructor Resource Center 

	Instructor's Manual (lesson plans incl.)
	e11_instructormanual
	Online Instructor Resource Center 

	Assignment Sheet
	e11_assignsheet
	Online Instructor Resource Center 

	Prepared Exam (Chapter & App)
	 
	Online Instructor Resource Center 

	      Prepared Exam-Chap instruction
	e11_exam_chap_instruction
	

	      Prepared Exam-Chap solution
	e11_exam_chap_solution
	

	      Prepared Exam-Chap Data
	e11_exam_chap_data
	

	      Prepared Exam-Chap Annotated Sol.
	e11_exam_chap_annsolution
	

	      Prepared Exam-Chap Scorecard
	e11_exam_chap_scorecard
	

	      Prepared Exam-App instruction
	e11_cumexam_instruction
	 

	      Prepared Exam-App solution
	e11_cumexam_solution
	 

	      Prepared Exam-App Data
	e11_cumexam_data
	 

	      Prepared Exam-App Annotated Sol.
	e11_cumexam_annsolution
	 

	      Prepared Exam-App scorecard
	e11_cumexam_scorecard
	 

	File Guide
	e11_file_guide
	Online Instructor Resource Center 

	Instructor Resource Card
	e11_ircard
	Online Instructor Resource Center 

	Objective Map
	e11_objectivesmap
	Online Instructor Resource Center 

	Online Chapter Review
	e11_chapt_checklist
	Companion Website for Students

	Grader Project
	 
	 

	       Grader-instruction
	e11_grader_instruction
	Online Instructor Resource Center 

	       Grader-solution
	e11_grader_solution
	

	       Grader-data
	e11_grader_data
	

	       Grader-annoted. Solution
	e11_grader_annsolution
	 

	       Grader-scorecard
	e11_grader_scorecard
	 

	Additional Projects (Practice & Mid Level)
	 
	Online Instructor Resource Center 

	       Additional Proj-Practice instruction
	e11_p_addproject_instruction
	

	       Additional Proj- Practice solutions
	e11_p_addproject_solution
	

	       Additional Proj-Practice Data
	e11_p_addproject_data
	

	       Additional Proj-Practice Ann Sol.
	e11_p_addproject_annsolution
	

	       Additional Proj-Practice Scorecard
	e11_p_addproject_scorecard
	

	       Additional Proj-Mid Level instruction
	e11_ml_addproject_instruction
	 

	       Additional Proj-Mid Level solutions
	e11_ml_addproject_solution
	

	       Additional Proj-Mid Level Data
	e11_ml_addproject_data
	

	       Additional Proj-Mid Level Ann Sol.
	e11_ml_addproject_annsolution
	 

	       Additional Proj-Mid Level Scorecard
	e11_ml_addproject_scorecard
	 



CHAPTER OBJECTIVES 
When students have finished reading this chapter, they will be able to:

· Customize Excel
· Change properties
· Share and merge workbooks
· Insert comments
· Track changes
· Check for issues
· Protect a workbook
· Save a workbook in different formats
· Send a workbook to others




CHAPTER OVERVIEW
The major sections in this chapter are:
Customization and Personalization: Customizing Excel; changing properties
Collaboration: Sharing and merging workbooks; inserting comments; tracking changes
Workbook Information: Checking for issues; protecting a workbook
Workbook Distribution: Saving a workbook in different formats; sending a workbook to others 


CLASS RUNDOWN
1. Have students turn in homework assignments.
2. Talk about chapter using discussion questions listed below. 
3. Use PowerPoint presentation to help students understand chapter content.
4. Demonstrate Excel 2013.
5. Run through Scripted Lectures for chapter.
6. Have students complete Capstone Exercise for Excel Chapter 11.
7. Use MyITLab for in-class work or to go over homework.
8. Give students Homework Handout for next class period. 

LEARNING OBJECTIVES
At the end of this lesson students should be able to:

· Enter a user name
· Display and add properties
· Add advanced properties
· Display the Document Panel
· Insert and edit a comment
· Share the workbook
· Add the Compare and Merge Workbooks command to the Quick Access Toolbar
· Compare and merge workbooks
· Highlight changes
· Accept and reject changes
· Use the Document Inspector
· Check accessibility and compatibility
· Add a signature line
· Mark as final
· Create a PDF file
· Save to the Web
KEY TERMS
Chapter X: Title	
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Accessibility Checker – A tool that detects issues that could hinder a user’s ability to use a workbook.
Collaboration – A process that occurs when multiple people work together to achieve a common goal by using technology to edit the contents of a file.
Comment – (1) A notation attached to a cell to pose a question or provide commentary. (2) A line that documents programming code; starts with an apostrophe and appears in green in the VBA Editor.
Comment indicator – A colored triangle in the top-right corner of a cell to indicate that the cell contains a comment.
Compatibility Checker – A tool that detects data and features that are not compatible with previous versions of Excel.
Digital signature – An electronic notation in a document to authenticate the contents.
Document Inspector – A tool that detects hidden and personal data in a workbook to remove.
Document property – An attribute, such as an author’s name or keyword, that describes a file.
History worksheet – A specially created worksheet through the Change Tracking feature that lists particular types of changes made to a workbook.
Metadata – Pieces of data, such as a keyword, that describe other data, such as the contents of a file.
Portable Document Format (PDF) – A universal file format that preserves a document’s original data and formatting for multi-platform use.
Shared workbook – A file that enables multiple users to make changes at the same time.
Signature line – A visible digital signature to authenticate the workbook.
SkyDrive – A central storage location where you can save and access files via an Internet connection.
Track Changes – A collaboration feature that records certain types of changes made in a workbook.
DISCUSSION QUESTIONS
· Which type of accessibility issues does the Accessibility Checker look for? Are these the only accessibility issues a user might have? 
· What other issues should a user be aware of when sharing a workbook (or any document) with others, besides the ones highlighted in this chapter? 
· What document properties available to the user are “new” or a surprise to students? 
· Collaboration is an integral part of both online coursework and today’s work environment. Ask students how they can transfer collaboration skills learned in an online course (not necessarily as part of the coursework) to the workplace. 
WHEN USING SCRIPTED LECTURE IN CLASS, DEMONSTRATE HOW TO:
· Enter a user name
· Display and add properties
· Add advanced properties
· Display the Document Panel 
· Insert and edit a comment
· Share the workbook
· Add the Compare and Merge Workbook command to the Quick Access Toolbar
· Compare and merge workbooks
· Highlight changes
· Accept and reject changes
· Use the Document Inspector
· Check accessibility and compatibility
· Add a signature line 
· Mark as final 
· Create a PDF file
· Save to the Web

CONNECTIONS PRACTICAL PROJECTS AND APPLICATIONS
· If your students have access to a SharePoint site, or you have access to another shared network location, have them practice sharing and collaborating on a workbook as they would in a “real-world” situation. 
· Divide students into small groups, and have each group develop a “study plan” in Excel—assignments, dates due, time needed, and so forth—for the semester in your class. Once the study plans are developed, have students post them online, and collaborate with each other on creating a single “study plan.” This also can be done with single students instead of groups. 
TEACHING NOTES
Customization and Personalization

Excel offers many options to customize and personalize the application to suit a user’s needs. 
A. Customizing Excel
· You can create a custom Auto Fill list in Excel. Excel will auto fill a row with the names of months or weekdays, but what if you have a series of words or names that you frequently use, that are not part of Excel? Click on File, then Options, then Advanced—scroll almost down to the bottom of the Advanced menu. Under the General heading, click Edit Custom Lists, and in the Custom Lists dialog box, click New List, and then enter your list of words. 
· Teaching Tip: Entering your user name and initials in one Microsoft Office program stores that information in the other Microsoft Office programs. On a private computer, changes you make become the default. If you are in a computer lab, however, the lab settings may delete your preferences when you log out.
· Teaching Tip: You can reset customizations if you no longer need them. To reset changes made to an original tab, select the tab in the Main Tabs list, click Reset, and then select Reset only selected Ribbon tab. To remove all customizations and return to the original settings, including new tabs created and Quick Access Toolbar customizations, click Reset, select Reset all customizations, and then click Yes. To remove a custom tab, right-click it in the dialog box and select Remove.
· Teaching Tip: After customizing the Quick Access Toolbar or Ribbon, you can share the custom settings with other people. Click Import/Export, select Export all customizations, enter a file name in the File Save dialog box, and then click Save. The file is saved as an Exported Office UI File format. To import the customizations file on another computer, click Import/Export, select Import customization file, select the file in the File Open dialog box, and then click Open.
B. Changing Properties
· Excel tries to help users with AutoCorrect options. Sometimes this is more annoying than helpful—you can disable them by clicking the File tab and choosing Options. Then, select Proofing in the left pane, click the AutoCorrect Options button, and then click the tabs to review the options. 
· Users may notice they are consistently changing Excel’s chart defaults. Instead of making those changes every time, change the default chart type and its attributes, then save it as a template. 
Collaboration

Collaboration is the process by which two or more individuals work together to achieve an outcome or a goal; the contents of a complex workbook often result from the collaborative efforts of a team of people. 
A. Sharing and Merging Workbooks
· Remind students that once a workbook is shared there are features that are no longer fully supported. Some of these include creating an Excel table, deleting worksheets, or merging cells. They also cannot work with XML data. 
· Teaching Tip: While sharing workbooks is a powerful collaboration tool, it does have limitations. Workbooks that contain tables may not be shared. Furthermore, the maximum number of users that can access the file at once is 256.
· If students get an error message for Source not found when sharing the workbook, click Change Source and choose another workbook. 
B. Inserting Comments
· It’s a good idea whenever sharing or merging workbooks to save backup copies of the originals—that way, if you make a mistake or need to start over, you still have the originals available to you. 
· Teaching Tip: If the comment box obstructs the view of a cell you would like to see, it can be repositioned by clicking the outer edge of the comment box and dragging to a new location. You can also drag a selection handle on the outer edge of a comment box to increase or decrease its size.
· Teaching Tip: To remove all comments at the same time, press Ctrl+G to display the Go To dialog box, click Special, make sure Comments is selected, and then click OK. This selects all cells containing comments in the current worksheet. Click the Home tab, click Clear in the Editing group, and then select Clear Comments.
C. Tracking Changes
· Sharing workbooks means it’s possible for more than one person to have the workbook open at the same time. You can see who else has the workbook open on the Editing tab of the Share Workbook dialog box. 
· Users can get automatic updates of other users’ changes periodically, with or without saving. Use Update changes on the Advanced tab of the Shared Workbook dialog box. 
· Teaching Tip: After reviewing the changes, you can turn off Change Tracking by clicking Track Changes in the Changes group, selecting Highlight Changes, deselecting the Track changes while editing check box in the Highlight Changes dialog box, and then clicking OK. If you turn off Change Tracking, the workbook is no longer shared, the history of changes made is lost, and other users who are sharing the workbook will not be able to save the changes they have made.
· Teaching Tip: The History worksheet is deleted when you save a workbook; however, you can copy and paste the values into a new worksheet that will remain when the workbook is saved.
· Teaching Tip: If Compare and Merge Workbooks is grayed out, click Share Workbook in the Changes group on the Review tab.
Workbook Information

Sharing workbooks creates the need to protect a workbook. 
A. Checking for Issues
· Because some changes may be permanent, this is another opportunity to remind users that a backup copy is a good idea before using Document Inspector. 
· Remind students all users with access to the network share have full access to the shared notebook unless cells have been locked and the worksheet protected to restrict access. 
· Teaching Tip: Before using Document Inspector, you should save the workbook and then run Document Inspector on the duplicate workbook, because you cannot always restore all data that Document Inspector removes.
· Teaching Tip: Look up Check file compatibility with earlier versions in Help to find out about Excel 2013 features that are not supported in earlier versions. This Help topic provides details about significant loss of functionality, what it means, and what to do to solve the problem.
B. Protecting a Workbook
· Discuss the pros and cons of password protecting a workbook, from both an employee’s and an employer’s points of view. 
· Teaching Tip: You should make a note of passwords you use for saving files. If you forget a password, you will not be able to open the file. 
Workbook Distribution

When sharing data with others, it is important to provide the data in a file format the recipients can manipulate. 
A. Saving a Workbook in Different Formats
· Before sharing a workbook, you will want to check it for spelling as well as data errors. When you run spell check in Excel, it only checks the current sheet. If you want to run a spell check on all the sheets in a workbook, group the sheets you want to check, then run the spell check. 
· Sometimes you need to print a workbook or worksheet instead of sharing it electronically. Each sheet in Excel has its own print options. You can change them individually, or save time by copying the settings from one sheet to another. Select the sheet that contains the options you want to use in another sheet, and then group the sheets you want to include (Ctrl + click the tabs of those sheets). Click the File tab, then click Print. Click Page Setup at the bottom, then click OK to close the Page Setup dialog box. Note that this method requires that you have already set up one sheet to print as desired—you are copying existing settings, not setting up new ones. 
· Don’t forget to make sure others have completed and saved their work before ending a shared workbook!
· Marking a workbook as “final” will not prevent someone else from editing it—to do that, use the Restrict Access option instead of marking it as final.
· Teaching Tip: As an alternative method to change the file format, you can choose Change File Type from the Export menu in the Backstage area. This will list all export options and corresponding details.
· Teaching Tip: If you have Adobe Acrobat (not just Adobe Reader) or other third-party applications that create PDF files installed, you can create a file through the Print options. Click the File tab, click Print, click the Printer arrow, select Adobe PDF, and then click Print. You will be prompted to enter a file name for the PDF file.
B. Sending a Workbook to Others
· Teaching Tip: If Outlook is not installed as your default e-mail client, you may not be able to use the Send Using E-mail options to start the e-mail program and attach the workbook. Instead, you should close the workbook, open your e-mail client, and then click the Attach button or command in that window to send the workbook as an e-mail attachment.
· Teaching Tip: When Microsoft Office 2013 is installed, you are required to create or sign in with an existing Windows Live account. This allows you to access SkyDrive without additional logins. If you attempt to access your SkyDrive account remotely, you will need to enter your user name and password. If you forget your SkyDrive password it can be reset at the following URL: https://account.live.com/ResetPassword.
 

ONLINE CHAPTER REVIEW
To find an online chapter review to help your students practice for tests, visit the Companion Website at http://www.pearsonhighered.com/exploring/.
ADDITIONAL WEB RESOURCES
1. What's new in Excel 2013—http://office.microsoft.com/en-us/excel-help/what-s-new-in-excel-2013-HA102809308.aspx
2. Online Excel Help—www.mrexcel.com  
3. Microsoft Tech Support—http://support.microsoft.com 

PROJECTS AND EXERCISES
	
	Data file
	Save As

	Hands-on Exercise 1
	e11h1Dinner.xlsx
	e11h1Dinner_LastFirst.xlsx

	Hands-on Exercise 2
	e11h1Dinner_LastFirst.xlsx, e11h2Main.xlsx, e11h2Main_Ian.xlsx, e11h2Main_Penny.xlsx
	e11h2Dinner_LastFirst.xlsx, e11h2History_LastFirst.xlsx, e11h2Main_LastFirst.xlsx

	Hands-on Exercise 3
	e11h2Main_LastFirst.xlsx
	e11h3Main_LastFirst.xlsx

	Hands-on Exercise 4
	e11h3Main_LastFirst.xlsx
	e11h4Main_LastFirst.xlsx, e11h4Main_LastFirst.pdf

	Practice Exercise 1
	
	e11p1Survey_LastFirst.xlsx

	Practice Exercise 2
	e11p2Dance.xlsx, e11p2Dance_Anita.xlsx
	e11p2Dance_LastFirst.xlsx, e11p2History_LastFirst.docx

	Mid-Level Exercise 1
	e11m1Lecture.xlsx, e11m1Samantha.xlsx
	e11m1Lecture_LastFirst.xlsx

	Mid-Level Exercise 2
	Na
	e11m2ScreenCapture_LastFirst.docx, e11m2CustomSet_LastFirst.exportedUI, e11m2Custom_LastFirst.xlsx

	BYC 2 Research
	e11b2CellPhone.xlsx
	e11b2CellPhone_LastFirst.xlsx, e11b2CellPhone2_LastFirst.xlsx

	BYC 3 Disaster Recovery
	e11b3Autos.xlsx
	e11b3Autos_LastFirst.xlsx,  e11b3AutosMemo_LastFirst.docx, e11b3Autos2_LastFirst.xls

	BYC 4 Collaboration
	e11b4Etiquette.xlsx
	e11b4Etiquette_LastFirst.xlsx

	Capstone
	e11c1HealthCare.xlsx, e11c1Dallas.xlsx, e11c1Atlanta.xlsx
	e11c1HealthCare_LastFirst.pdf, e11c1HealthCare_LastFirst.xlsx, e11c1HealthCare_LastFirst.xls, e11c1History_LastFirst.docx


 
CHAPTER REVIEW/ANSWERS TO END OF CHAPTER MATERIAL

Key Terms Matching Answer Key

1. 	SkyDrive (N) is a central storage location where you can save and access files via Internet connection. 
2. 	A Signature line (M) enables a person to type or insert a visible digital signature to authenticate the workbook. 
3. 	The Portable Document Format (PDF) (K) is a universal file format that preserves a document’s original data and formatting for multiplatform use. 
4. 	A Digital signature (F) is an electronic notation in a document to authenticate the contents. 
5. 	The Accessibility Checker (A) detects issues that could hinder a user’s ability to use a workbook.
6. 	The Compatibility Checker (E) detects data and features that are not compatible with previous versions of Excel.
7.	The History worksheet (I) lists particular types of changes made to a workbook.
8. 	The Document Inspector (G) detects hidden and personal data in a workbook to remove.
9.	A Comment indicator (D) is a colored triangle in the top-right corner of a cell to indicate that the cell contains a comment.
10.	Track Changes (O) records certain types of changes made in a workbook.
11. 	Collaboration (B) occurs when multiple people work together to achieve a common goal by using technology to edit the contents of a file.
12. 	A Shared workbook (L) is a file that enables multiple users to make changes at the same time.
13. 	A Document property (H) is an attribute, such as an author’s name or keyword, that describes a file.
14. 	A Comment (C) is a notation attached to a cell to pose a question or provide commentary. 
15. 	Metadata (J) are pieces of data such as a keyword, that describe other data, such as the contents of a file.
Multiple Choice Answer Key
1. Which statement about comments in Excel is true?
(b) Position the mouse pointer over the cell containing a comment indicator to display a comment box. 
2. Which document property cannot be changed within the Backstage view?
(d) Last Modified date.
3. What is the default file format for a basic Excel 2013 file?
(c) .xlsx
4. Which tool detects issues that could hinder a user’s ability to use a workbook?
(a) Accessibility Checker
5. The Track Changes feature does not detect what type of change?
(d) Applying Percent Style for the range B4:B10
6. A workbook that has been marked as final:
(a) Opens in Read-Only mode. 
7. The _______ tool detects particular properties, such as Author, and removes those properties from a file that you plan to distribute. (b) Document Inspector
8. If you want to save a file in a format that preserves worksheet formatting, prevents changes, and ensures that the document looks the same on most computers, save the workbook in the _______ file format.
(d) .pdf
9. If you want to save a workbook to a highly secure central location to enable efficient collaboration:
(b) Save the workbook to a SharePoint site or to a shared SkyDrive folder.
10. You can do all of the following except _______ for both customizing the Ribbon and customizing the Quick Access Toolbar.
(c) Print
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